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New Features: 
 

 
New tool implemented to populate ‘System Identifier’ field in the headers of LAS files. 
 

 
 

A new tool – ‘Add System ID’ – has been implemented to populate or edit the ‘System Identifier’ field in the Public 

Header Block of LAS files.  This field can hold up to 32 bytes (characters) of information.  If a value is already present 

in the file header(s), it will be silently overwritten by the tool.  This tool will not allow complete removal of existing 

entries. 

 

 
 

 
 

Several new shortcut keys implemented. 
 

 
 

A new shortcut key – ‘Ctrl-J’ – has been implemented to color points or TINs by RGB values stored at the point level.  

This shortcut is the equivalent of clicking the ‘Color by RGB’ rendering option button  on the ‘View’ tab.   

 

Additionally, three new shortcuts that help speed up hand-filtering have been implemented: ‘Q’ to enable the panning 

tool, ‘W’ to start the ‘Place Adjustable Cross-Section Line’ tool (when a Cross-Section/Profile window is open), and ‘E’ 

to start the ‘Filter Region’ tool that allows a box to be dragged over an area being filtered. 
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Enhancements: 
 

 
Performance enhancements to LAS loading, navigating, and rendering. 
 

 
 

Many significant improvements have been made to LAS loading times, point and TIN rendering, and Pan/Zoom 

operations. 

 
 
 
Tile shapefile should not be already loaded in either ‘Reference Shapefiles’ or ‘Breaklines’ 
layers prior to loading in ‘Tiles’ layer. 
 

 
 

When a shapefile is added to the 'Tiles' layer, MARS® will check and silently remove it first from the 'Reference 

Shapefiles' or 'Breaklines' layers if the same path/file exists in either of those layers. 

 
 
 
‘Add Spatial Index’ tests for blank ‘System Identifier’ field in LAS file headers and 
populates any that are found. 
 

 
 

When using the standalone ‘Add Spatial Index’ tool or choosing ‘Spatially Index LAS Files and Add Them to Project’ if 

prompted during loading, all files will be tested for empty 'System Identifier' header fields.  If blanks are found, the tool 

will populate this field with 'OTHER'.  Files with values already in place will not have this field altered. 

 
 
 
QC Module USGS 1.2 tool tests for blank ‘System Identifier’ field in LAS file headers. 
 

 
 

In the QC Module ‘USGS NGP – Version 1.2’ drop-down tool, test DPH-1 now tests for blank ‘System Identifier’ fields 

in the headers of both swath and tiled LAS files, and reports on them in the sub-section DPH-1.1 tables. 

 
 
 
Overlap bit-flagged points forced on for ‘Flightline Separation – JPEG 2000’ export type. 
 

 
 

Since Overlap bit-flagged points often delineate the area to be measured in a ‘Flightline Separation – JPEG 2000’ 

raster export type, those points are now forced on as part of the export. 
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Breaklines can now be saved at the root of a drive. 
 

 
 

Breaklines saved using the ‘Save Breaklines to Shapefile(s)’ button on the ‘Breaklines’ tab can now be stored in the 

root folder of a drive. 

 
 
 
Changes to final PDF report highlighting for QC Module USGS 1.2 test DPH-14. 
 

 
 

Improvements have been made to test DPH-14 in the QC Module ‘USGS NGP – Version 1.2’ drop-down tool.  PDF 

report highlighting of non-zero point counts has been enhanced to emphasize anything above the minimum USGS 

class requirements (yellow background), as well as disallowed class/bit-flag combinations (red font). 

 
 
 
Withheld flagged points not used in most tools and tests of the ‘QC Module’. 
 

 
 

Points flagged as Withheld are no longer used in any processing for the ‘LiDAR Workflow QC – 1 LiDAR Data 

Checks’, ‘LiDAR Workflow QC – 2 LiDAR Calibration Checks’, or ‘USGS NGP – Version 1.2’ tools in the QC Module 

drop-down list, except for tests DPH-12 and DPH-14 in the ‘USGS NGP – Version 1.2’ tool. 

 
 
 
Withheld flagged points not used in ‘Check Point Report’ tool. 
 

 
 

All points flagged as Withheld are now omitted from any processing and reporting when running the ‘Check Point 

Report’ tool. 

 
 
 

List of Bug Fixes: 
 

 
 

• Bug fixed causing striping in tiled IMG Grid intensity raster exports. 

• Bug fixed allowing Flightline Separation raster export output to be clipped to a boundary even when that option 

was unchecked. 

• Bug fixed preventing optional classification reassignment from working when using the ‘Folder’ option of the ‘Clear 

Bit Flags’ tool. 

• Bug fixed causing an error when using the ‘Set Keypoint Bit Flag’ option of the ‘Class to Bit Flag’ tool. 

• Bug fixed creating tiled Regular Flightline Separation rasters when the Measurable option was chosen. 

• Bug fixed in the QC Module ‘LiDAR Workflow QC – 1 LiDAR Data Checks’ drop-down test DC7 that was 

incorrectly using Withheld flagged points in Flightline Separation raster creation. 

• Bug fixed in the QC Module ‘LiDAR Workflow QC – 2 LiDAR Calibration Checks’ drop-down test CC1 that was 

incorrectly using Withheld flagged points in both Regular and Measurable Flightline Separation raster creation. 

• Bug fixed in the QC Module ‘USGS NGP – Version 1.2’ drop-down test DPH-11.1.2 that was incorrectly using 

Withheld flagged points in Flightline Separation raster creation. 

• Bug fixed causing shortcut key ‘I’ (Inspect) to fail when used in the Cross-Section/Profile window. 

• Bug fixed causing the ‘Remove Duplicates’ tool to fail when the entire LAS file has duplicate points. 

• Bug fixed leaving Virtual Tile artifacts in exported Float Grid rasters when using the ‘Auto Calculate Virtual Tile 

Size’ option.  
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• Bug fixed that was not allowing all individual LAS entries in the Table of Contents to be unchecked for display. 

• Bug fixed in the ‘Check Point Report’ tool that was incorrectly using Withheld flagged points in processing. 

• Bug fixed to display an advisory message rather than cause a crash when no classes are selected for the ‘Class 

to Bit Flag’ tool. 

• Bug fixed causing wrong drop-down list option to display when using ‘Edit Selected Set’ for hand editing.  

• Bug fixed that prevented shortcut key ‘Ctrl-M’ from displaying the correct point classifications. 
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New Features: 
 
 
New filter for modifying bit flag status implemented. 
 

 

 

A new filter – ‘Change Bit Flags’ – has been implemented that allows for modifying the ‘set’ or ‘clear’ status of several 

bit flags.  Options include re-classifying those points that have had bit flag modifications and limiting the operation to a 

single collection scan. 

 

 

 
 
 
New multi-threaded tool implemented to perform the same functionality as the new ‘Change 
Bit Flags’ filter (above) without loading the LAS data. 
 

 
 

A new tool – ‘Change Bit Flags’ – has been implemented to perform the same functions as the ‘Change Bit Flags’ filter 

(mentioned above), but with multi-thread capability and with no need to load the LAS data first.  Input LAS data is 

pathed out along with a pre-existing polygon shapefile to define the area(s) to be processed.  An output folder is 

selected for the modified files.  The tool can be found on the ‘Tools’ tab under the ‘Bit Flag Settings’ drop-down. 
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New panning method implemented using compatible mouse. 
 

 

 

When using a scroll-wheel mouse that has a button action for the wheel, panning can be done by pushing and holding 

the scroll wheel while moving the mouse. 

 
 
 
New shortcut key implemented to turn on display for Classes 2 and 8 only. 
 

 

 

A new shortcut key combination – ‘Ctrl-M’ – has been implemented to turn on display for Classes 2 and 8 only.  Most 

pre-LAS v1.4 data used Class 8 for Model Keypoints (rather than bit flags) so this shortcut quickly enables all ground 

points to be displayed. 

 

 

 
Enhancements: 
 

 
Extended returns can now be selected for viewing, filtering, and Export. 
 

 

 

All possible returns (up to 15 for LAS v1.4 data) can now be selected - in any combination - for viewing, filtering, and 

inclusion in ‘Export’. 
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More complete and consistent LAS statistics provided for several tools. 
 

 

 

Statistics that are reported in shapefile attribute tables for several tools – ‘Populate Statistics on Tile Scheme’, ‘Create 

Tile Scheme’, ‘Collection Scan Polygon Generator’ - and are now more homogenous across the tools and include 

more information.  Bit flag counts by tile/file as well as extended return counts (for up to 15 discrete returns) are now 

included. 

 

 
 
Default ground and reference classes in many tools have been modified to correspond to 
the ASPRS LAS v1.4 specification. 
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The default ground and reference classes have been changed for many tools’ interfaces to correspond to the standard 

class numbers in the ASPRS LAS v1.4 specification. 

 
 
 
‘Make Color/Description Default’ button removed from main ‘Classifications Display 
Settings’ interface. 
 

 

 

The ‘Make Color/Description default’ button has been removed from the ‘Classifications Display Settings’ interface that 

opens when the ‘Classification’ button is clicked in the ‘Display Selection’ section of the ‘View’ tab.  These settings are 

hard-coded to comply with the ASPRS LAS v1.4 specification and should not be permanently changed.  There is an 

option to make customized settings files that can be loaded for certain projects as needed without changing the 

default values that are used when a MARS® session is started. 

 

 
 
Extraction tools removed from list of discrete filters in ‘Batch Process Tiles’. 
 

 
 

The four extraction tools – Area by Slope, Building Polygons, Canopy Density, and Class Polygons – have been 

removed from the list of built-in filters that can be selected on the ‘Script/Filters’ tab of the ‘Batch Process Tiles’ tool.  

They can still be used with the various ‘manual’ extraction method tools and as part of a macro script. 

 
 
 
‘Projection’ tab of ‘Export’ tool modified when exporting TIFF Grids. 
 

 

 

The ‘WKT’ (Well-Known Text) section of the ‘Projection’ tab of ‘Export’ has been disabled when exporting TIFF Grids.  

TIFF Grids store this information in a GeoTIFF format in the header of the raster file, or in a separate world (TFW) file. 

 
 
 
‘Exclude withheld points’ checkboxes removed from all class selection interfaces. 
 

 

 

All class selection interfaces now omit the ‘Exclude withheld points’ checkboxes that were once used to control display 

and processing of classes 128-255.  These classes were often treated as the withheld versions of classes 0-127 in 

older (pre-LAS v1.4) data.  Withheld status is now determined by bit flag. 

 
 
 
‘Smart Clip’ filter now uses scan angle rank values with LAS v1.4 PDRF 6 or higher data. 
 

 

 

LAS v1.4 PDRF 6 or higher data stores both the newer scan angle (-15000 to 15000) and legacy scan angle rank (-90 

to 90) values per point.  The easier-to-understand scan angle rank values, in degrees from nadir, are used by this filter 

just as they are for the similar ‘Scan Angle’ filter. 
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Non-visible Withheld points will no longer be selectable when hand filtering. 
 

 
 

When hand-filtering in either the LAS Map View or Cross-Section/Profile window, points that are bit-flagged as 

Withheld and are not turned on for display can no longer be selected and re-classified using any of the hand filtering 

tools: paintbrushes, Edit Line String Above/Below, Edit Scrape Above/Below, Edit Digitized Polygon, and Edit 

Selected Polygons. 

 
 
 
Grid Type ‘Intensity’ only available for certain export types. 
 

 

 

Only the ‘Grid - Esri ASCII Grid’, ‘Grid - Float Grid’, ‘Grid - IMG’, and ‘Grid - TIFF’ Export Types allow selecting the 
‘Intensity’ Grid Type. 

 
 
 
‘Use temporary local disk space …’ option requires a minimum amount of input information 
before the required space can be calculated. 
 

 

 

A warning pop-up will appear when trying to check on the ‘Use temporary local disk space to speed up processing’ 

option for either the ‘LiDAR Workflow QC – 1 LiDAR Data Checks’ or ‘LiDAR Workflow QC – 2 LiDAR Calibration 

Checks’ drop-down if there is not enough information provided on the ‘Input’ tab.  At a minimum, the ‘Required NPS’ 

must be entered along with the path to the LAS Files to be tested. 

 
 
 
Performance improvement in tiled Float Grid exports. 
 

 
 

Processing time has been significantly reduced for tiled Float Grid exports when using the ‘TINned Surface Fill’ option 

in the ‘Fill Gap’ section of the ‘Grid’ tab. 

 
 

 
Intensity raster exports have cell values rounded to nearest integer. 
 

 
 

When exporting intensity rasters using either the ‘Grid - Esri ASCII Grid’ or ‘Grid - Float Grid’ export types, cell values 

will now be rounded to the nearest integer. 

 
 
 
Output file naming changed for ‘By Collection Scan’ export Layout types. 
 

 

 

For Export types ‘LAS’ and ‘Text – ASCII’ when using the ‘By Collection Scan’ or ‘By Collection Scan From User-

defined Box’ Layout formats, output files will be automatically named based on the collection scan numbers of the 

points they contain, plus any optionally supplied prefixes and suffixes. 
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List of Bug Fixes: 
 

 
 

 Bug fixed causing saved bookmarks to not be honored when a 3D viewing operation has taken place since the 

bookmark was saved. 

 Bug fixed causing ‘Esri ASCII Grid’ type intensity rasters to store cell values with non-zero decimal places. 

 Bug fixed preventing warning pop-up from appearing when ‘Output Directory’ is blank in Export.  

 Bug fixed causing NoData cells of Unsigned 16-bit Intensity IMG rasters to have a value of 0 (zero) rather than 

65535. 

 Bug fixed causing ‘Color by Ground Color’ rendering option to not display RGB point colors when no image is 

loaded. 

 Bug fixed preventing several shortcut keys from working:  ‘underscore’ ( _ ), ‘Ctrl-P’, ‘Shift-P’, ‘Shift-S’. 

 Bug fixed causing bad on-the-fly contours when part of a polygonal breakline (e.g., lake) is outside main window 

extent. 

 Bug fixed causing ‘Lock to view 100%’ to remain enabled after all LAS files are unloaded. 

 Bug fixed causing a program hang in QC Module ‘LiDAR Workflow QC – 1 LiDAR Data Checks’ drop-down test 

DC4 and ‘LiDAR Point Density – Float Grid’ export type when Withheld bit-flagged points exist. 

 Bug fixed in QC Module ‘USGS NGP – Version 1.2’ drop-down test DPH-11.2 causing a crash if no Project 

Boundary is pathed out. 

 Bug fixed preventing the ‘Blend’ rendering option from working in some situations when coloring by Elevation 

Throughout or Elevation Repeat with the TIN rendering method enabled. 
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New Features: 
 
 
New tool – ‘USGS NGP – Version 1.2’ – added to the QC Module for testing LAS v1.4 
datasets against the latest USGS NGP Lidar Base Specification Version 1.2. 
 

 

 

A new version of the USGS tool has been added within the QC Module (‘QA/QC’ tab).  Named ‘USGS NGP – Version 

1.2’, this tool is designed exclusively for use with LAS v1.4 datasets.  (Note: the original ‘USGS NGP – Version 1.0’ 

tool still exists for testing older versions - LAS v1.0 through LAS v1.3 - of lidar data.  The tool tests for compliance with 

the latest USGS lidar specifications, as contained in the document USGS NGP Lidar Base Specification Version 1.2 

(November 2014), and also does file integrity testing.  Results are presented in PDF form and include pertinent 

descriptions from the USGS document, tables, histograms, rasters, screen captures, and more. 

 

 
 
 
 
New tool – ‘LAS Separate’ – for splitting multi-channel files into their individual channels. 
 

 

 

A new tool – ‘LAS Separate’ – has been added to the ‘Tool’ tab.  It separates merged multi-channel LAS v1.4 files into 

separate individual channel files, one file for each scanner channel value found in the original merged file.  The 

Scanner Channel bit flag values must be present in the original merged file for this tool to work - possible bit flag 

values are 0, 1, 2, and 3. 

 

 
 
 
 
 
New button – ‘Select Polygons’ – for selecting one or more pre-loaded shapefile polygons 
prior to using the ‘Edit Selected Polygons’ tool. 
 

 

 

http://www.merrick.com/site/static/mars/documentation/tm11-b4_v1.2.pdf
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A new button – ‘Select Polygons’ – has been added to the ‘Edit/Filter’ tab to allow selection of any pre-existing 

polygon(s) before the ‘Edit Selected Polygons’ tool is used for point reclassification.  A polygon shapefile must be 

loaded as a Reference Shapefile to use this tool. 

 

 
 

 
Enhancements: 
 

 
‘Check Point Report’ (previously known as Control Report) has been updated to test in 
accordance with the latest ASPRS and USGS accuracy guidelines. 
 

 
 

The ‘Check Point Report’ tool (‘QA/QC’ tab) has been completely re-designed to test lidar datasets against the latest 

ASPRS vertical accuracy guidelines, found in ASPRS Positional Accuracy Standards for Digital Geospatial Data, 

(EDITION 1, VERSION 1.0) that was published in November 2014.  The tool also incorporates many of the latest 

USGS vertical accuracy specifications, as described in the USGS NGP Lidar Base Specification Version 1.2 

document, also published in November 2014. 

 
 
 
‘Filters’ tab of ‘Export’ now includes the option of including/excluding those points that 
have specific bit flags set. 
 

 

 

On the ‘Filters’ tab of the ‘Export’ tool, a new section allows for user-selectable inclusion/exclusion of lidar points that 

have specific bit flags set.  In the example below, points that have the ‘Synthetic’ bit flag set to on will not be part of 

the export, but ‘Withheld’, ‘Overlap’, and ‘Edge of Collection Scan’ flagged points will be included.  This option is 

particularly relevant to LAS v1.4 data, but older versions may have some of the bit flags set as well.  Additionally, only 

those points that are bit-flagged in the included categories will be part of the export set if the ‘Flagged points only’ box 

is checked. 

 

 
 
 

http://www.asprs.org/a/society/committees/standards/Positional_Accuracy_Standards.pdf
http://www.asprs.org/a/society/committees/standards/Positional_Accuracy_Standards.pdf
http://www.merrick.com/site/static/mars/documentation/tm11-b4_v1.2.pdf
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‘Repair’ button added to ‘Verify/Remove LAS Projection Info’ tool to fix some EVLR / VLR 
coordinate system tags. 
 

 
 

A new button – ‘Repair’ – has been added to the interface of the ‘Verify/Remove LAS Projection Info’ tool.  For LAS 

v1.4 files with incorrect combinations of ‘User ID’ and/or ‘Record ID’ values in superseded coordinate system EVLRs 

and VLRs, this function will correct those values to be in compliance with ASPRS requirements. 

 

 
 

 

 
A pop-up warning will appear if the wrong version of the QC Module is used. 
 

 

 

If the version of LAS data being pathed out is incompatible with the version of the QC Module being run, a pop-up 

warning will appear.  ‘USGS NGP – Version 1.2’ is intended only for LAS v1.4 data, and ‘USGS NGP – Version 1.0’ is 

intended only for LAS v1.3 or earlier data. 

 
 
 
New list of Classifications/Descriptions included to match ASPRS specification for LAS 
v1.4, Point Data Record Format 6 or higher. 
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A new list of point Classification/Description combinations is now included to match the ASPRS specification for LAS 

v1.4, PDRF 6 or higher data.  An unlimited number of custom settings files can still be made for use with older version 

data or any other purpose. 

 

 
 
 
 
Changes made to some extraction tools when used in a macro script. 
 

 
 

To simplify and enhance the functionality of the ‘Area by Slope’, ‘Building Polygons’, and ‘Class Polygons’ extraction 

tools within a batch macro script, several changes have been made to output shapefile naming.  See the ‘Extraction 

Tools’ and ‘Batch Filter/Extraction Processing’ sections in the ‘Data Classification (Manual and Batch)’ topic of the 

Help File for details.   

 
 
 
Data must be spatially indexed before it can be processed with ‘Remove Duplicates’ tool. 
 

 

 

To obtain accurate results, data must be spatially indexed before it can be processed with the ‘Remove Duplicates’ 

tool.  If the data does not have spatial index records, a prompt will appear to remind the user. 

 
 
 



 

 6
 
  

The format of projection system tags created is determined by the version of LAS files 
being exported. 
 

 
 

When writing coordinate reference (aka projection) system tags during ‘LAS’ and ‘Grid – LAS’ exports, the ‘Export’ tool 

now forces the GeoTIFF format for LAS v1.0 thru v1.3 files, and the WKT (Well-Known Text) format for LAS v1.4 files.  

For LAS v1.4, either a VLR or EVLR can be selected to store the WKT tag. 

 
 
 
‘Cache points into available RAM’ option now disabled. 
 

 

 

Due to LAS datasets becoming increasingly larger in file size (frequently surpassing the available RAM in a computer) 

as well as the possibility of lost work caused by an unexpected shutdown of MARS® prior to a save operation, the 

‘Cache points into available RAM’ option (‘Options’ tab, ‘Performance’ button) has been disabled.  LAS data will be 

read from disk and ‘live’ edit changes (such as hand filtering) are committed to disk as soon as they occur.  

Additionally, with newer, faster hard drives such as SSD, the performance difference between disk-based and RAM-

based operations is constantly shrinking. 

 
 
 
‘Clear Bit Flags’ tool allows cleared points to be assigned to a new class. 
 

 

 

There is a new option for the ‘Clear Bit Flags’ tool that allows those points that have their bit flags cleared (set to ‘0’ or 

off) to be reassigned to a different classification. 
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‘Lock to view 100%’ button now available at all times with new warning messages 
implemented. 
 

 
 

The ‘Lock to view 100%’ button on the ‘View’ tab is now available for use at all times, including when the density of 

points displayed is naturally at 100% due to the extent of the ‘LAS Map View’ window.  Confirmation pop-ups will 

appear when the tool is enabled and the ‘Fit to View’ button is clicked, or when selecting a layer in the Table of 

Contents and using the ‘Zoom to’ button.  Display performance may be degraded in these situations. 

 
 
 
Status of ‘Elevation Repeat Colors Options’ parameters now saved in MPD. 
 

 

 

The parameters set for the ‘Elevation Repeat Colors Options’ tool (‘View’ tab, Elevation Coloration Options drop-

down) are now stored in a MARS® Project Document (MPD) file when it is created or saved. 

 

 
 

 

 

Order of items in a WKT-based CRS tag changed to match the latest USGS guidelines. 
 

 

 

The order of elements in a WKT (Well Known Text) based CRS tag stored in a version 1.4 LAS file has been changed 

to match the latest USGS guidelines (dated July 2016). 

 
 
 
Change made to spelling of User ID entry for superseded WKT records after updated 
guidance received from USGS. 
 

 
 

Anywhere an existing WKT record (VLR or EVLR) is superseded through the use of tools such as 'Add CRS Info', 

'Export', 'GeoCalc', etc., the User ID for the superseded record is now correctly spelled as "LASF_Spec". 
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Option to set File Source IDs to match existing Point Source IDs during Collection Scan 
Renumbering. 
 

 
 

There is a new option for the ‘Manual’ tab of the ‘Collection Scan Renumbering’ tool that uses existing Point Source 

IDs to set the File Source ID for processed files.  The option is available for either the ‘Single File’ or ‘Folder’ method 

of renumbering. 

 

 
 
 
 
‘Remove Duplicates’ tool criteria have been changed. 
 

 

 

In order to be consistent with duplicate point testing in the QC Module ‘USGS NGP – Version 1.2’ drop-down (test 

DPH-1.2), the criteria for determining if points are duplicated have been modified to X, Y, and Z values and  

timestamp. 

 
 
 
Label change made to QC Module PDF report pages for Intensity testing. 
 

 
 

For the QC Module ‘USGS NGP – Version 1.0’ and ‘LiDAR Workflow QC – 1 LiDAR Data Checks’ drop-downs, a label 

change has been made to the bottom of the tabular portion of the ‘Report on Intensity’ tests in the PDF reports.  The 

label ‘Average’ below the individual file results now reads ‘Overall Statistics’ to properly reflect the results displayed. 

 

 
 
 
‘Extract by Tile’ checkbox and label removed from the options interfaces of all shapefile 
producing extraction tools. 
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On the ‘Area by Slope’, ‘Building Polygons’, and ‘Class Polygons’ extraction tool options interfaces, the checkbox and 

label for ‘Extract by Tile’ have been removed since they are no longer needed. 

 
 
 
‘Edit/Filter’ tab labeling changed for some tools to make space for a new editing button. 
 

 

 

Several tools on the ‘Edit/Filter’ tab have new shorter labels to make room for the new ‘Select Polygons’ tool in the 

Edit section. 

 

 
 
 
 
Default output PDF file names changed for both versions of the USGS QC Module to 
differentiate between them. 
 

 
 

The upcoming addition of a second USGS QC Module - ‘USGS NGP – Version 1.2’ – has created the need to modify 

the default names of the PDF reports produced to indicate which version created them – ‘QC_1_0_All.pdf’ and 

‘QC_1_0_All_Summary.pdf’ or ‘QC_1_2_All.pdf’ and ‘QC_1_2_All_Summary.pdf’. 

 
 
 
Enhancement made to GeoCalc and GeoEdit to make an additional Vertical Reference 
System entry visible. 
 

 

 

An enhancement has been made to the ‘geodata_72.xvw’ file (part of the Blue Marble Geographics package licensed 

in MARS® ) to make an additional Vertical Reference System visible for selection.  ‘NAVD 88 (ftUS)’, which uses an 

EPSG code of 6360, can now be selected from the Vertical | North America | United States section of the Vertical 

Coordinate System datasource. 

 

 
 
 
 
Multi-threading option implemented for ‘Add CRS Info’ tool. 
 

 

 

To decrease processing time, an option to use multi-threading has been added to the ‘Add CRS Info’ tool. 
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Settings XML files renamed for both versions of the USGS QC Module to differentiate 
between them. 
 

 
 

The upcoming addition of a second USGS QC Module - ‘USGS NGP – Version 1.2’ – has created the need to rename 

the settings XML files that are produced each time the Version 1.0 or 1.2 tools are run.  The new naming will indicate 

which version was used. 

 

 
 

 

 

‘Add CRS Info’ (LAS files) tool enhanced to allow writing of WKT format coordinate 
reference system information for LAS v1.4 files in a VLR. 
 

 

 

An option for writing WKT format coordinate reference system (CRS) information in a Variable Length Record (VLR) 

for LAS v1.4 files has been added to the ‘Add CRS Info’ (LAS files) tool.  This will prevent having a mix of EVLRs and 

VLRs in the same LAS file when the existing records are in VLR format.  Note that neither option is now set as a 

default – the user must select one before running the tool. 
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Scanner Channel bit flag value displayed in ‘Point Properties’ window. 
 

 
 

When available in the LiDAR data, scanner channel bit flag values (indicating which channel in a multi-channel system 

collected a return) will be displayed in the ‘Point Properties’ window when a point is identified with the ‘Inspect’ tool.  

This value can be stored in LAS v1.4, Point Data record Format 6 or higher data. 

 

 
 
 
 
Open Street Maps has been added to the list of ‘Default Servers’ available as a source to 
the WMS tool. 
 

 

 

When using the ‘Add WMS Images’ tool to add Web Map Service layers to the LAS Map View window, ‘Open Street 

Maps’ is now an available option.  Unlike the Bing Map layers, these are free to use and do not require a license 

token.  There are four layers available from this server. 

 
 
 
Enhancements made to export options for Intensity rasters. 

 
 

When exporting Intensity rasters to any of the available formats, the options for ‘Data Type’ on the ‘Grid’ tab of the 

‘Export’ interface have been clarified and enhanced.  The ‘Float 32’ option is now disabled since there is no need to 

use floating values to store integer intensity values.  The two data types available are ‘Int 32’ (which is a signed data 

type), and ‘Unsigned 16’. 
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Missing raster data in test 1.9.2 of QC Module ‘USGS NGP – Version 1.0’ drop-down 
explained. 
 

 
 

Data from sensors that do not store differentiating Scan Direction values cannot be used to create rasters for QC 

Module ‘USGS NGP – Version 1.0’ drop-down test 1.9.2 (current Riegl airborne sensors are an example of this).  An 

explanation of the absence of rasters will be listed in the PDF report for this test section. 

 

 

 

Change to label text for LAS export type to include reference to infrared. 
 

 

 

For the ‘LAS’ export type, the 'Write RGB Values from' section label has been changed to ‘Write RGB(N) Values from’ 

to include a reference to infrared values that can be stored in Point Data Record Format 8 LAS files. 

 

 

 
 
 
Point inspection tool now reports on NIR values for LAS v1.4 PDRF 8 data. 
 

 

 

The LiDAR point inspection tool (  ‘Inspect’ ) now reports ‘Infrared’ values along with RGB values for LAS v1.4 

Point Data Record Format 8 data. 
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Appearance of TIFF intensity rasters improved with certain source data. 
 

 
 

The appearance of exported TIFF intensity rasters has been improved when the source LAS data contains 12-bit or 

16-bit intensity values. 

 
 
 
Additional options implemented in ‘Bit Flag Display Settings’ tool. 
 

 

 

The ‘Bit Flag Display Settings’ tool now includes options for viewing points by ‘Scanner Channel’ and ‘Scan Direction’ 

bit flag values (when available in the data).  The default for the new settings is for all scanner channels and both scan 

directions to be displayed. 

 

 
 

 
 
 
GeoTranslate allows a larger number of files to be added and processed in one operation. 
 

 
 

Due to a known bug (in a Blue Marble Geographics component), when files are added to the ‘Import Data’ box of the 

GeoTranslate interface, occasionally the path to one of the files becomes corrupt.  When this happens, only those files 

in the selected list before the bad path are added to the list to be translated.  MARS® now displays a message when 

this happens telling the user that only some of the selected files have been added, and that the ‘Add File(s)’ function 

can be used again to add the remaining files.  This can be done as often as necessary until all needed files have been 

added. 
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‘Bit Flag Display Settings’ now independently controlled for main and cross-section 
windows. 
 

 

 

The settings made in the ‘Bit Flag Display Settings’ tool are now maintained independently for both the ‘LAS Map 

View’ and ‘Cross-Section/Profile’ windows. 

 
 
 
Blank entry for ‘Internal Buffer Size’ value for Grid-based export types treated the same as 
a zero. 
 

 

 

A blank entry in the ‘Internal Buffer Size’ entry box when using the ‘TINned Surface Fill’ option for ‘Fill Gaps’ is now 

treated the same as a zero (0) for Grid-based export types. 

 
 
 
‘Projection’ tab removed from ‘Export’ interface for ‘Flightline Separation – JPEG 2000’ 
export type. 
 

 

 

The ‘Projection’ tab has been removed from the ‘Export’ tool interface when the type is ‘Flightline Separation – JPEG 

2000’ as this info cannot be stored for a JPEG 2000 raster. 

 
 
 
Implemented Save Settings and Load Settings functionality for GeoCalc. 
 

 
 

The GeoCalc tool now has the capability of saving settings to an XML file and loading those settings at any later time 
 
 
 
‘Inspect’ tool displays same point properties when used Cross-Section/Profile window as in 
main window. 
 

 

 

The ‘Inspect’ tool now displays the same point properties in the pop-up window when used on points in the Cross-

Section/Profile window as it does when used on points in the LAS Map View window. 
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GeoCalc v7.2 SDK from Blue Marble Geographics has been implemented to include new 
and enhanced coordinate systems, datums, height models, and more. 
 

 
 

The version 7.2 GeoCalc SDK is now included in MARS®.  It includes many new and enhanced coordinate systems, 

datums, height models, and transformations.  Of particular importance is the addition of the Geoid 2012B height 

model, to comply with the USGS LiDAR Base Specification’s requirement that the latest hybrid geoid model published 

by NGS be used to convert ellipsoidal heights to orthometric heights.  These same new and enhanced entries are also 

available in GeoEdit (individual coordinate point testing) and GeoTranslate (vector translation). 

 

 
 
 

List of Bug Fixes: 
 

 
 Bug fixed causing a crash when trying to load the results shapefile from the ‘Populate Statistics on Tile Scheme’ 

tool. 

 Bug fixed causing no output when using a discrete filter (not a macro) with Batch Process Tiles. 

 Bug fixed causing LAS export to v1.4 data to set all Scanner Channel bit flag values to ‘0’ (zero) for multi-channel 

data. 

 Bug fixed causing ‘LAS Splitting’ tool error when data had more than 5 returns. 

 Bug fixed causing crash of ‘3D Image’ export type when using LAS v1.4 data. 

 Bug fixed causing an error message when exporting to ‘Hillshade – JPEG 2000’ and using the ‘TINned Surface 

Fill’ ‘Fill Gap’ option. 

 Bug fixed in page title names for QC Module ‘USGS NGP – Version 1.0’ drop-down test 1.6.2. 

 Bug fixed causing display of data in Latitude/Longitude (Geographic) coordinate systems to be incomplete when 

viewed in 2D. 

 Bug fixed causing incorrect RGBN values in the output when exporting to v1.4 PDRF 8. 

 Bug fixed causing extra points to be re-classified when using the ‘Scan Angle’ filter. 

 Bug fixed causing ‘ghost’ artifacts of removed LAS files to remain visible after the files were unloaded and new 

files were added. 

 Bug fixed to allow LAS export to v1.4 PDRF 8 to work with all layout types. 

 Bug fixed causing different results when hand filtering using the ‘Filter Region’, ‘Batch Script Test’, and ‘Filter 

Digitized Polygon’ tools in the same area. 

 Bug fixed in ‘3D Image’ export type causing the WKT tag in LAS v1.4 exports to display only a ‘COMPD_CS’ 

section. 

 Bug fixed causing incorrect Scan Angle Rank values in LAS v1.4 exports created from LAS v1.2 data. 

 Bug fixed for Float Grid export causing water bodies with surrounding poly shapefiles to not be flattened. 

 Bug fixed causing no output when using ‘Export Area’ on very large LAS files, even if dragged area was small.  

 Bug fixed causing breakline ‘Arcs’ (shortcut key ‘A’ during compilation) to have their vertices set to Z values of ‘0’ 

(zero). 

 Bug fixed causing point display density to change when switching rendering methods. 

 Bug fixed causing the wrong points (not the selected Source points) to be reclassed when using ‘Filter Selected 

Polygons’ with the ‘Plane Analysis’ filter. 

 Bug fixed causing performance slowdowns after removing LAS files and adding new ones when an open Cross-

Section/Profile window no longer has points in its extent. 

 Bug fixed causing both the ‘Batch Script Test’ and ‘Script Edit’ tools to keep operating with the previously-loaded 

macro after switching to a new macro. 

 Bug fixed causing a regular ‘Flightline Separation’ raster to be created when the ‘Measurable RMSDz FSR’ box 

was checked. 

 Bug fixed causing a missing completion message when using the ‘Remove Duplicates’ tool. 

 Bug fixed in GeoCalc causing output v1.4 files to display a ‘Reserve’ value of ‘43707’ in WKT tag VLRs/EVLRs.  
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 Bug fixed causing no output when running ‘Batch Process Tiles’ with a single-step macro containing the ‘Plane 

Analysis’ filter. 

 Bug fixed causing some exported points from ‘3D Image’ export type to have RGB values of ‘0’ (zero). 

 Bug fixed regarding no output when either QC Module ‘LiDAR Workflow QC – 1 LiDAR Data Checks’ drop-down 

test DC4 or export to ‘LiDAR Point Density – Float Grid’ was run. 

 Bug fixed causing a crash of the QC Module ‘LiDAR Workflow QC – 2 LiDAR Calibration Checks’ drop-down test 

CC1 when an NPS value of 0.3 units was entered. 

 Bug fixed causing slowdowns in rendering performance for corridor-shaped data when a Cross-Section/Profile 

window was open. 

 Bug fixed in ‘Export’ causing the incorrect ‘Global Encoding’ value in LAS file headers when the ‘Single File from 

Selected Tiles’ layout was used. 

 Bug fixed causing the ‘Undo’ button and shortcut key ‘Ctrl-Z’ to stop working after using the ‘Filter Digitized 

Polygon’ tool. 

 Bug fixed causing incorrect week number to be assigned to output file when using ‘GPS Time Conversion’ tool to 

convert to Adjusted GPS Time. 

 Bug fixed causing no or partial output when using a discrete extraction tool with Batch Process Tiles. 

 Bug fixed causing crash when exporting to ‘3D Image’ after opening an MPD. 

 Bug fixed when outputting LAS v1.4 data using ‘Batch Process Tiles’ causing incorrect: ‘Global Encoding’ file 

header values, Scanner Channel bit flag values, and extended return information. 

 Bug fixed causing ‘Depression Coder’ tool to fail if multiple contour shapefiles were pathed out. 

 Bug fixed causing LAS export of v1.4 data to create point extent and extended return errors. 

 Bug fixed causing striped artifacts in some ‘Hillshade – JPEG 2000’ exports. 

 Bug fixed regarding non-working shortcut keys ‘S’ (toggle loaded shapefiles on/off) and ‘I’ (toggle ‘Inspect’ tool 

on/off). 

 Bug fixed causing crash if more than approximately 440 files were added to the ‘Add CRS Info’ tool in one 

processing run. 

 Bug fixed causing ‘From/To Class’ settings for hand filter to reset to ‘All’ when a MPD file was opened that 

contained discrete class settings. 

 Bug fixed causing crash if a non-numeric entry was made in the ‘Set Cut Depth’ entry box after using the ‘D’ 

shortcut key with the Cross-Section/Profile window open. 

 Bug fixed causing a program hang when running QC Module ‘USGS NGP – Version 1.0’ drop-down test 2.5. 

 Bug fixed causing some export layout types to fail when using extended return (>5) LAS v1.4 data. 

 Bug fixed causing occasional program crashes when using the ‘Fast TIN’ performance mode during certain hand 

filtering operations. 

 Bug fixed causing QC Module ‘USGS NGP – Version 1.0’ drop-down tests 0.0 and 1.4 to hang when ‘ID’ field was 

missing from tile layout shapefile. 

 Bug fixed causing missing horizontal system EPSG code in WKT-based Coordinate Reference System (CRS) 

tags. 

 Bug identified in ‘Area by Slope’ extraction tool causing the ‘Generate Buffer (inner)’ option to produce incorrect 

shapefiles.  That option has been disabled until further notice. 

 Bug fixed causing ‘Ctrl-Z’ keyboard shortcut to undo the last two operations when used after editing in the Cross-

Section/Profile window. 

 Bug fixed in ‘Add CRS Info’ tool causing incorrect ‘Global Encoding’ values in LAS file headers of LAS v1.4 files. 

 Bug fixed causing ‘Ctrl-A’, ‘Ctrl-G’, and ‘Ctrl-K’ keyboard shortcuts to fail while in TIN rendering display mode. 

 Bug fixed causing occasional shifts in exported Float Grid rasters when using the ‘TINned Surface Fill’ option. 

 Bug fixed regarding missing ‘Source Classifications’ parameter info when viewing/editing the options of the 

‘Building Polygons’ extraction tool as part of a macro script. 

 Bug fixed causing a crash when choosing ‘Measurable FSR’ option in ‘LiDAR Workflow QC – 2 LiDAR Calibration 

Checks’ drop-down test CC1, ‘USGS NGP – Version 1.0’ drop-down test 1.9.1, or ‘Flightline Separation – JPEG 

2000’ export. 

 Bug fixed causing incorrect return statistics for the QC Module ‘USGS NGP – Version 1.0’ drop-down test 1.1. 
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 Bug fixed causing gaps in the QC Module ‘LiDAR Workflow QC – 1 LiDAR Data Checks’ drop-down tests 

DC5/DC6 and the QC Module ‘USGS NGP – Version 1.0’ drop-down tests 1.5/1.6 rasters. 

 Bug fixed causing incomplete above ground points when exporting to ‘3D Image’ type. 

 Bug fixed causing a spatial indexing hang after GeoCalc has been used to translate LAS files. 

 Bug fixed regarding missing ‘Change Vert Units’ button and functionality in GeoEdit 7.2 and GeoCalc 7.2. 

 Bug fixed in the ‘GPS Time Conversion’ tool causing thinned points to have incorrect info. 

 Bug fixed causing the ‘Reference Reclass’ tool to miss some reclassifications when the ‘Z Position’ option is used. 

 Bug fixed causing a crash when exporting IMG (Imagine) intensity rasters from 16-bit intensity LiDAR data. 

 Bug fixed regarding the appearance of IMG intensity rasters exported from 12-bit intensity LiDAR data. 

 Bug fixed causing a crash when multi-threading the ‘LiDAR Spatial Reclass’ tool. 

 Bug fixed causing a crash when the ‘Building Polygons’ extraction tool is used in a macro script (Batch). 

 Bug fixed was preventing 1-point LAS files from loading. 

 Bug fixed that caused excessive dangles in contour shapefile exports. 
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